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1 Introduction 
This chapter provides an introduction to this document and the VWorks 14.1 
software. 
The topics are:
• “About this document” on page 2
• “Software overview” on page 3
• “Supported devices” on page 4
• “User information access” on page 5
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About this document

VWorks Automation Control 14.1 is integrated with OpenLab ECM XT 2.6, which is 
described in the OpenLab Server 2.6/OpenLab ECM XT 2.6 Functional Design 
Specification. This VWorks software 14.1 specification provides descriptions of the core 
functions provided by VWorks software 14.1. For step-by-step instructions on how to 
configure and use VWorks software 14.1, see the documents provided in the VWorks 14 
Knowledge Base. The primary documents are listed in the following table. For details on 
how to access these guides, see “User information access” on page 5.

Figure Documents supporting VWorks and devices that use VWorks

Product Document

VWorks Automation Control VWorks Automation Control installation Guide

VWorks Plus Configuration and Administration 
Guide

VWorks Standard Configuration and 
Administration Guide

VWorks Plus Quick Reference

VWorks Standard Quick Reference

VWorks Automation Control Setup Guide

VWorks Automation Control User Guide

VWorks Quick Guide for Protocol Authors

BenchCel Microplate Handler BenchCel Microplate Handler User Guide

BenchCel Quick Guide

Bravo Platform Bravo Platform Safety and Installation Guide

Bravo Platform Unpacking Guide

Bravo Platform Quick Guide

Bravo Platform User Guide

Centrifuge with Loader Microplate Centrifuge User Guide

Microplate Centrifuge Quick Guide

Microplate Centrifuge Unpacking Guide

Microfuge Centrifuge with Loader User Guide

Microfuge Centrifuge with Loader Quick Guide

Microfuge Loader Unpacking Guide

Microplate Labeler Microplate Labeler User Guide

Microplate Labeler Quick Guide

Microscan Bar Code Reader Microscan Barcode Reader Device Driver Guide
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Software overview

VWorks 14.1 runs on a single computer and controls standalone automation devices or 
integrated automation devices in a laboratory automation workstation. The software is 
available as compliance-enabled and standard editions, VWorks Plus and VWorks 
Standard respectively. VWorks Plus supports compliance with Part 11 of Title 21 of the 
Code of Federal Regulations (21 CFR Part 11).

Software development process and validation

The Agilent Declaration of Software Quality shipped with each software package 
documents the software development and testing steps executed as part of the 
development cycle. The development process is registered to the ISO 9001 quality 
standard.

Major components

• OpenLab for VWorks. The VWorks software is integrated with the OpenLab Control 
Panel and Shared Services. Control Panel is the user interface for Shared Services, 
which are set of administrative services. An administrator uses Control Panel to 
configure VWorks user access, software licenses, storage, e-signature levels, and 
audit trail settings.
– VWorks Plus. Uses Content Management to store VWorks files, records of 

interest, and audit trails. The files are stored in a predefined VWorks Project 
folder in the Content Management repository. A system administrator can use 
the Content Browser to view and edit the project structure and contents. See 
the following figure for the relationship between these components.

Labware MiniHub Labware MiniHub Safety and Installation Guide

Labware MiniHub User Guide

Labware MiniHub Quick Guide

PlateLoc Sealer PlateLoc Sealer User Guide

PlateLoc Sealer Quick Guide

Pump Module Pump Module and Accessories User Guide

BioTek Liquid Handlers BioTek Liquid Handler Device Driver Guide

BioTek Reader BioTek Gen5 Reader Device Driver Guide

Product Document
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Figure VWorks Plus edition architecture

– VWorks Standard. Uses the local file system. Shared Services stores the files in 
a predefined VWorks Project folder. See the following figure for the relationship 
between these components.

Figure VWorks Standard edition architecture

• VWorks components. The VWorks software provides the instrument control tools 
for Agilent automation devices. Based on a user’s role and privileges, users can 
create and run protocols on the automation devices.

VWorks Plus features

VWorks Plus provides the following features to enable compliance with the FDA rules 
and guidelines of 21 CFR Part 11 and similar rules:
• Data security. Physical protection of data by limiting access to the system and 

preventing unauthorized access.
• Data Integrity. Protecting raw data and metadata and preventing these from 

unauthorized modification, and linking raw data and results to reproduce the 
original results at any time, for example, in an audit situation, and document each 
new result copy.

• Audit traceability. Documenting who did what to the results and when.
For details, see “Compliance” on page 53.

Supported devices

The VWorks 14.1 software supports a variety of Agilent automation devices in 
standalone mode or in a BenchCel workstation configuration.
See“VWorks Plugins” on page 65 for more information about VWorks supported 
devices.
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User information access

The user information is available in the following locations:
• Knowledge base. The help system for the Automation Solutions products is 
available from:

– Help menu within the VWorks software: Select Help > Knowledge Base or press 
F1.

– From the Windows desktop: Select Start > All Apps > Agilent Technologies > 
VWorks Knowledge Base.

• Context-sensitive help. Clicking the Context Help button on the VWorks toolbar 
converts the pointer to a question mark and enables you to select specific areas or 
icons in the main window to open a relevant topic or document.

• PDF files. The PDF files of the user guides are installed with the VWorks software 
(C:\Program Files (x86)\Agilent Technologies\VWorks\UserGuides) and are 
available in the VWorks Knowledge Base.

• Website. You can search the online VWorks Knowledge Base or download the 
latest version of any PDF file from the Agilent website at www.agilent.com/chem/
askb.

https://www.agilent.com/chem/askb
https://www.agilent.com/chem/askb
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2 Network and computer requirements
This chapter provides an overview of network and computer requirements for 
VWorks 14.1 software.
The topics are:
• “Computer requirements” on page 8
• “Domain requirements” on page 8
• “Firewall settings” on page 8
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Computer requirements

See the VWorks 14.1 Site Preparation Checklist for the computer hardware 
requirements.

Domain requirements

With domain-based authentication individual machines must always be able to 
communicate with domain components, not just to login but also to receive 
authorization for many routine functions.

Firewall settings

For communication to transpire, some ports in the firewall must be accessible to the 
OpenLab components. See OpenLab Server 2.6/OpenLab ECM XT 2.6 Functional Design 
Specification for more information.
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3 Installation 
This chapter provides the functional design specification of VWorks 14.1 software 
installation.
The topics are:
• “OpenLab for VWorks installer” on page 10
• “VWorks 14.1 installer” on page 10
• “Software Verification Tool” on page 10
• “Bravo IQOQ” on page 11
• “Licensing” on page 11
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OpenLab for VWorks installer

The OpenLab for VWorks installer is a wizard that installs and configures the following 
required software tools and components:
• Control Panel and Shared Services. These components of the OpenLab software 

control the user access and storage for the VWorks software. The installer places a 
Control Panel shortcut icon on the Windows desktop.

• Content Browser and Content Management (VWorks Plus only). Shared Services 
stores VWorks files in Content Management, which is a secure storage repository. 
Content Browser enables viewing and managing Content Management.

• Agilent Software Verification Tool. Agilent support providers may use this tool to 
verify the software installation. See “Software Verification Tool” on page 10 for 
more information.

VWorks 14.1 installer

The VWorks 14.1 installer is a wizard that installs:
• VWorks software.
• Bravo IQOQ Test Utilities. Authorized Agilent support providers may use these 

utilities to perform qualification on the corresponding Agilent device. 
The VWorks installer automatically does the following:
• Enables projects in OpenLab Control Panel and creates the VWorks Project and 

standard folder structure and adds default instrument and application objects in 
the OpenLab Control Panel. 

• Publishes VWorks user roles and groups. 
• Publishes all standard labware entires, labware classes, and liquid classes.

Software Verification Tool

The Agilent Software Verification Tool is installed with each Agilent software 
component. This utility has a reference file providing an index of the files required for a 
proper installation. The utility checks the reference list against the files installed, their 
locations and revisions, including operating system files with specific dependencies.
This test is typically performed at installation and can be performed at any time to verify 
the file level integrity of the software installed on each computer in the installation. Test 
reports can be printed or saved to files.
The tool can be used to verify a successful installation of a new version or patch. This 
does not replace the Installation Qualification (IQ) service, which is delivered by an 
authorized Agilent service provider.
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Bravo IQOQ 

To qualify the accuracy of Bravo liquid handling, the customer can order Bravo 
qualification services from Agilent. The Bravo IQOQ service requires a reagent kit in 
addition to the software and is performed by an Agilent field specialist.

Licensing

VWorks requires a license to run the software and the license can be published on the 
OpenLab Control Panel.
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4 Software interface
This topic provides the functional design specification of VWorks 14.1 software 
interface.
The topics are:
• “OpenLab Control Panel interface” on page 14
• “VWorks interface” on page 14
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OpenLab Control Panel interface

See the OpenLab Server 2.6/OpenLab ECM XT 2.6 Functional Design Specification.

VWorks interface

Main window interface

The VWorks main window consists of menus and menu commands, toolbars, tabbed 
areas, and a status bar. The content of each of these items can change depending on 
whether you are viewing a device file, protocol, or form.

Device file interface

Terminology Description

Title bar Displays the name of the window.

Menus Lists menu commands.

Toolbars Displays button commands.

Work area Displays device files, protocols, or forms.

Log and progress area Displays the Main Log, Pipette Log, Time Constraint Log, 
Progress, and Runset Manager.
You use these tabs primarily to monitor various aspects of 
the run and to set up multiple protocol runs in a sequence.

Status bar Displays the state of the software.

Terminology Description

Available Devices area Displays the following tabs:
• Available devices. The list of devices you can add to 

the device file.
• Workspace.The list of protocols, forms, and device 

files that are currently open.
• Available Macros. The list of macros created to 

expedite the protocol writing process.
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Protocol interface

Device file area Displays the list of devices that are added to the device file.
The area also allows you to:
• Initialize all devices
• Initialize selected devices
• Close selected devices
• Delete selected devices
• Open the diagnostic software of the selected device

Device properties area Displays the properties you can set for the selected device 
in the device file.

Terminology Description

Terminology Description

Available tasks area Displays the following tabs:
• Available Tasks. The list of tasks you can add to a 

protocol. The list of tasks can vary, depending on the 
devices added in the device file and the process or 
subprocess selected.

• Workspace. The list of protocols, forms, and device files 
that are currently open.

Protocol area Displays the following:
• Startup Protocol. Contains tasks that must be run before 

the main protocol starts.
• Main Protocol. Contains tasks of the protocol.
• Cleanup Protocol. Contains tasks that must be run after 

the main protocol finishes.
• Protocol Options. References the device file and contains 

additional information associated with the protocol.
An open VWorks form will display in the Protocol and Task 
Parameters areas. If the form displays in full screen mode, 
the entire form fills the VWorks window.
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Labware Editor

The Labware Editor is a window that you open from the Tools menu in the VWorks 
window. Users with VWorks technician or VWorks administrator privileges can use this 
tool to manage the labware definitions. The Labware Editor has two tabbed pages:
• Labware Entries. Provides tools for creating and editing labware definitions.
• Labware Classes. Provides tools for creating and editing labware classes and the 

labware entries for each class.
For more details, see “Labware Editor” on page 29.

Liquid Library Editor

The Liquid Library Editor is a tabbed window that opens from the Tools menu in the 
VWorks window. The Liquid Library Editor provides tools for users with VWorks 
technician or VWorks administrator privileges to enter values for properties that affect 
pipetting speed, accuracy, and precision.

Pipette Technique Editor

The Pipette Technique Editor is used to define any number of pipette techniques. After 
you create a technique, it becomes available for the liquid-handling tasks in the Bravo 
Subprocess.

Inventory Editor

The Inventory Editor is a tabbed window that opens from the VWorks Tools menu only if 
a connection to the inventory database is established. The inventory database 
maintains a list of labware located in long-term labware storage devices. You use the 
VWorks Inventory Editor to access the data in the inventory database.

Task Parameters 
area

Displays one or more of the following, depending on the task 
selected:
• Task Parameters. Contains parameters associated with 

the selected process plate or task.
• Custom Parameters. Allows you to create variables to be 

used by the selected task. Might also contain parameters 
or options associated with the task.

• Device Selection. Contains the list of devices that will 
perform the selected task. Also allows you to set up a 
pool of devices for the same task to increase throughput 
and backup devices in case the primary devices are in an 
error state.

• Advanced Settings. Allows you to add JavaScript to 
change the task parameters or pass information to and 
from an external database during a protocol run.

Terminology Description
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Experiment Editor

The Experiments Editor is a window that opens from the VWorks Tools menu only if a 
connection to the Experiments database is established. The Experiments Editor and 
database enables the tracking of parameter settings involved in preparing a microplate 
for downstream analysis. The protocol and form must be associated with an 
experiment ID and include parameters tagged to be tracked automatically.

Form Designer

The Form Designer is opened from the File > New or File > Open menu in the VWorks 
window. The Form Editor is opened from the VWorks Tools menu. The Form Designer/
Form Editor provides tools for users with VWorks technician or VWorks administrator 
privileges to create and edit VWorks forms. A form is a customized user interface that 
enables operators to run an associated VWorks protocol. A VWorks user who creates 
protocols can design forms to simplify the operator duties when it comes time to run 
the associated protocols.

Error Library 

The Error Library window opens from the VWorks Tools menu. The error-handling 
library contains a collection of automatic responses to specific error messages 
developed by the user. 
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5 OpenLab for VWorks
This chapter provides the functional design specification of the OpenLab 
component of the VWorks 14.1 software.
The topics are:
• “OpenLab Control Panel” on page 20
• “Control Panel activity log and administrative reports” on page 21
• “Control Panel settings published by VWorks installer” on page 21
• “Content Browser” on page 23
• “OpenLab for VWorks tools” on page 23
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OpenLab Control Panel

Configuration requirements

In order to run VWorks 14.1, the software must first be configured using OpenLab 
Control Panel. The VWorks user must have project and instrument privileges to log in to 
VWorks 14.1. 
The OpenLab Control Panel functions are divided into views, which are selected through 
view buttons in the lower left pane of the application’s user interface.
The views are:
• Instruments. This view specifies the instrument settings. For VWorks 14.1, the 

instrument is essentially the computer that is running the VWorks software.
• Projects. This view specifies the VWorks project settings, including the project 

name and who has project access privileges. For VWorks Plus, the project settings 
also include the audit comment and e-signature settings.

• Administration. This view provides access to administration functions such as 
authentication, security, user access and so forth.

Administration settings

The following describes the settings required to configure VWorks 14.1.

Authentication
VWorks 14.1 supports Internal or Windows Domain as authentication providers.

Security Policy
Internal authentication. You can set all policy parameters in the Control Panel.
Windows Domain authentication. You set only the inactivity time in the Control Panel. All 
other parameters are defined by the Windows operating system.

Users, groups, and roles
VWorks software publishes the required VWorks Groups and Roles.
For more information on users, groups, and roles, see the VWorks Plus Configuration 
and Administration Guide and the VWorks Standard Configuration and Administration 
Guide.

email server
If you want to allow the VWorks software to send email notifications, for example, when 
a run error occurs, the Control Panel must be connected to an email server.
• The computer running the VWorks software must be able to communicate with 

your outgoing email server (SMTP server). The email server settings must be 
configured in the Control Panel.

• After connecting to an email server in the Control Panel, you must also enable email 
notifications in the VWorks Options dialog box. For details, see the VWorks 
Automation Control User Guide.



21

5   OpenLab for VWorks
Control Panel activity log and administrative reports

VWorks 14.1 Functional Desgin Specification

Control Panel activity log and administrative reports

System Activity Log

Note: For information on activity logs in the VWorks software, see “VWorks logs” on 
page 49.
The System Activity Log contains information on the various events associated with 
Shared Services. 
For the VWorks software, only the following types of events are recorded:

– System
– Instrument
– Project Management
– User
– Group
– Security
– License

The messages can come from other Shared Services components, such as the user 
management, system messages, or event messages.

Administrative Reports view

In the Administrative Reports view, you can export various XML or PDF reports related 
to the OpenLab for VWorks system configuration, including:
• Instruments Report. For VWorks 14.1, typically, only one instrument is configured 

per workstation.
• Projects Report. Provides detailed information about configuration and access 

privileges for a project or projects for the VWorks workstation.
• Roles and Privileges Report. Describes all roles defined on the system, including 

details of all privileges included in each role.
• System Report. Provides a consolidated view of the system, which includes all 

information about the instrument controller, instrument, projects, roles, users, and 
groups.

• User's and Group's Role Assignment Report. Provides an overview of all users and 
groups with their assigned roles.

Control Panel settings published by VWorks installer

Project settings

VWorks project
The following VWorks project is configured automatically during the VWorks software 
installation:
/VWorks Projects/VWorks
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The VWorks project folder stores the labware entries, liquid classes, pipetting 
techniques, device files, protocols, forms, runsets, and other miscellaneous files for 
your protocols.
Additional projects can be created and configured for different users running different 
workflows.

Audit trail settings
Available in VWorks Plus only.The VWorks software prompts for an audit comment 
when a user changes a record of interest.The audit comment settings are specified in 
the Workstation tab of the Projects view in the OpenLab Control Panel.

Signature settings
Available in VWorks Plus only. VWorks uses the OpenLab electronic signature service. 
The signature settings are configured as part of the Project settings. For details, see the 
VWorks Plus Configuration and Administration Guide.
Before the E-Signatures feature is available for VWorks use, a connection to the VWorks 
E-Signatures database (PostgreSQL) must be established in the VWorks Options dialog. 
For details, see the VWorks Automation Control Setup Guide.

Control Panel instrument settings

For VWorks 14.1, the instrument is created by default when the software is installed. 
Typically, only one instrument is configured in Control Panel for VWorks Plus and 
VWorks Standard. The instrument is basically the computer that controls the 
automation device or devices. For details on configuring the VWorks devices, see 
“VWorks Plugins” on page 65.
For VWorks 14.1, the instrument has the following properties:

The Configure Instrument button in the ribbon opens the VVWorks Instrument 
Configuration dialog box where you can enter a name for the Workstation Folder, which 
stores the VWorks global option settings, the device profiles, the log activity files, and so 
forth that are specific to this VWorks workstation. By default, the software creates a 
folder titled, Workstation.

Property Description

Name By default, the software uses the 
computer name. You can type a 
different name for the instrument.

Application VWorks Workstation (This value is 
fixed.)

Instrument controller Computer name (This value is 
fixed.)

Instrument type VWorksInstrDriver

Default project By default, the VWorks project is 
selected.
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Content Browser

Overview

VWorks Plus only. The OpenLab Content Browser enables viewing and editing of the 
VWorks project. Login privileges for Content Browser are configured in the Control 
Panel. For a detailed description of the features, see the Help available in the Content 
Browser.

VWorks implementation

A VWorks user with appropriate privileges can use Content Browser to:
• Edit the VWorks project structure, including creating or uploading files and folders
• Restore records
The Sign File feature in Content Browser is not supported in the VWorks software. To 
ensure proper tracking of signatures for VWorks records, only the VWorks e-signatures 
feature should be used.

OpenLab for VWorks tools

Shared Services Maintenance utility

The Shared Services Maintenance utility is automatically installed with VWorks 14.1.
• Backup and Restore tab. For VWorks Standard, this tab provides a means for 

backing up and storing the Shared Services data. This tab does not apply to 
VWorks Plus.

• Windows Domain tab 
In the Shared Services Maintenance utility, the Windows Domain tab is relevant if 
you use Windows domain authentication to identify your VWorks 14.1 users. 
OpenLab for VWorks must be given access to the server where these credentials 
are stored. In the Windows Domain tab, you specify or change the credentials that 
OpenLab for VWorks will use to access your Windows domain server.

• Server Settings tab. VWorks 14.1 typically has only the connection to the local 
computer.

Backup and Restore utilities

For VWorks Plus, the Backup and Restore utilities provide a means for backing up and 
restoring the following:
• Configuration file
• Databases for Shared Services, Content Management, and Data Repository
• Solr indexes
• Content and Archive storage locations
• Alfresco cache
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• Certificate server
• e-signatures for completed record-state transitions and closed experiment IDs
In addition to running the Backup/Restore utilities, you must also backup/restore the 
following databases, which are not included:
• VWorks Inventory database. You can export the inventory database to create a 

backup copy.
• VWorks Experiments database. You can export all experiment IDs to a backup file 

(.expTags file) and make a backup copy of any archived experiment ID files.
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6 VWorks specifications
This chapter provides the VWorks 14.1 software functional design specification.
The topics are:
• “Software overview” on page 26
• “Relationship of components in VWorks software” on page 27
• “Labware Editor” on page 29
• “Liquid Library Editor” on page 29
• “Pipette Technique Editor” on page 30
• “Inventory Editor” on page 30
• “Experiments Editor” on page 31
• “Device files” on page 32
• “VWorks protocols” on page 33
• “VWorks forms” on page 46
• “Error library” on page 47
• “Macro Library” on page 48
• “Exporting and importing” on page 48
• “VWorks Backup Manager” on page 49
• “VWorks logs” on page 49
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Software overview

Features available for VWorks Standard and VWorks Plus

The VWorks software uses dynamic scheduling to run the tasks in a protocol. The 
scheduler determines which task to run next based on the availability of resources 
moment-by-moment, to reduce idle time during a protocol. This causes the software to 
re-determine the sequence of task execution every time a protocol is run. As a result, 
run times can vary for a given protocol. However, you can specify a time interval 
between two dependent tasks using the Time Constraints feature.

Features Description

Define labware You create labware definitions that describe 
the labware you will use during protocol runs.

Define liquid classes Bravo Platform only. You use a liquid class to 
describe the liquid-handling properties for a 
task in a protocol.

Manage inventory Storage devices only. For devices such as the 
Labware MiniHub, the Inventory Editor helps 
you track barcodes and labware as you move 
them into and out of storage or incubation.

Track experiments You can set up an experiments database and 
use experiment IDs to track the parameter 
settings for a given application run.

Set up devices You define any devices used in a protocol in a 
VWorks device file.

Create protocols Protocols determine the sequence of tasks to 
be automated in a run. For example, you can 
use a protocol to apply barcode labels to 100 
microplates.

Create forms A form provides a simplified interface for 
running a protocol, which can be helpful for 
users who have limited or infrequent 
experience with the VWorks software.

Create pipetting techniques Bravo Platform only. You can create pipetting 
techniques that describe the pipetting 
methods.

Run, pause, monitor, and stop 
protocols

You can start, pause, monitor, and stop a 
protocol run from the controlling computer.
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Relationship of components in VWorks software

The VWorks software uses different components (files and databases) to run 
protocols. It is important to understand the relationships between each of the 
components in the software. Changing settings or options in one component will affect 
one or more of the other components.

Component descriptions

The following table lists and describes the primary VWorks software components.
Note: VWorks treats these as records of interest. For details on records of interest, see 
“Records of interest” on page 56.

Component Description File 
extension

Opening this component loads...

Global settings

A file that contains a collection of 
labware properties that the VWorks 
software uses to handle a labware type 
in the automation system.

.xml Labware definitions

A file used by the Hit Pick Replication 
task that specifies the dispense pattern 
in destination microplates.

.xml Dispense information in 
destination microplates

A file that contains pipetting settings for 
different liquid types.

.xml Liquid class information

A file that specifies the x- and y-axis 
offset when pipetting.

.xml Pipette x- and y-axis offset 
information

Device-related files

A file that contains:
• The list of devices the software will 

communicate with and control
• Configuration information of each 

device
• Communication settings (profile)

.dev • Device profile
• Teachpoint file (BenchCel 

device)

A file that contains a collection of 
settings that the VWorks software uses 
to control a specific device.

.xml Teachpoints or teachpoint file 
(applicable to some devices 
such as the BenchCel device)

A device-dependent file that contains 
your teachpoint settings.

.xml Teachpoint definitions

Protocol-related files
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Relationships of VWorks components

• Labware definitions are used by all protocols.
• Liquid classes, pipetting techniques, and hit-pick formats are used by protocols 

containing liquid-handling tasks. In particular, hit-pick formats are used by the Hit 
Pick Replication task.

• Each protocol references a single device file that contains one or more devices.
• More than one protocol can reference the same device file.
• Each device (or robot) references a single device profile.
• Some devices, such as the BenchCel device, reference a single teachpoint file.

A file that contains instructions for 
performing a run.

.pro • VWorks software (if it is not 
already open)

• Device file
• VWorks form (if configured 

in Protocol Options)

A simplified user-interface that can be 
linked to a protocol for operators to use 
when running the protocol.

.VWForm VWorks form and associated 
protocol

Component Description File 
extension

Opening this component loads...
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Miscellaneous files

Files created in software other than the VWorks software, such as barcode input files 
(.bar, .csv, or .txt), hitpick input files (.csv), inventory files (.sql), JavaScript files (.js), and 
so forth, must be imported into Shared Services storage before the files are available 
for use in the VWorks software. 

Labware Editor

The Labware Editor enables you to create labware definitions. Each labware definition 
consists of a labware entry and clabware class. VWorks administrator or technician 
roles are required to use the Labware Editor.
Some common labware and some Agilent labware comes already defined in the 
VWorks software. However, these labware definitions will still require some fine-tuning 
for each particular system.
For a detailed description of the Labware Editor, refer to the VWorks Automation 
Control 14.1 Setup Guide.

Labware entry 
A labware entry is the collection of properties or parameter values that describe a 
specific type of labware. This information is used by the VWorks software to command 
the robot and other devices to do tasks based on the information in the definition. Each 
labware entry is saved as an .xml file in Shared Services storage.
VWorks Plus only. The labware entries are records of interest. The software 
automatically logs audit trails for the labware entries that are in the In Validation and 
Released states. Optionally, the software can log audit trails for these records while 
they are In Development. You cannot edit or delete labware entries that have 
transitioned to the Released state.

Labware classes
Labware classes are sets of labware entries, grouped so they are easier to manage 
than many individual labware entries. Each labware class is saved as an .xml file in 
Shared Services storage.
Labware classes are used in combination with the device manager to restrict which 
types of labware can be used on which devices during a protocol run.
VWorks Plus only. The labware classes are records of interest for which the software 
automatically logs audit trails. These records are exempt from transitioning through 
development states.

Liquid Library Editor 

The Liquid Library Editor provides tools for users with technician or administrator 
privileges to enter values for properties that affect pipetting speed, accuracy, and 
precision.
Default liquid library entries are installed with the VWorks software.
You use the Liquid Library to fine-tune the volume aspirated or dispensed by your Bravo 
Platform.
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The values entered into the Liquid Library Editor can be saved as a collection, known as 
a liquid class. 
For a detailed description of the Liquid Library Editor, see the VWorks Automation 
Control Setup Guide.

How liquid classes are stored
Each liquid class is saved as an .xml file in Shared Services storage.
VWorks Plus only. The liquid classes are records of interest. The software automatically 
logs audit trails for liquid classes that are in the In Validation and Released states. 
Optionally, the software can log audit trails for these records while they are in the In 
Development state. 

Calibrating the Bravo Platform
The Liquid Library Editor also has an equation editor that can be used to calibrate the 
Bravo Platform.

Pipette Technique Editor

You can define a pipette technique to use different pipetting methods. Different 
applications can benefit from different pipetting methods. For example, in multiplexed 
microplates, dispensing at an offset from the well center can improve distribution of the 
fluid. In cell-based assays, moving the pipette to the side of the wells minimizes the 
removal of the cells from the center or reading area of the well.
You use the Pipette Technique Editor to define any number of pipette techniques. After 
you create a technique, it becomes available for the following liquid-handling tasks in 
the Bravo Subprocess:
• Aspirate
• Dispense
• Mix
• Pin Tool
You create, edit, and manage (copy, rename, delete) pipette techniques in the Pipette 
Technique Editor dialog box accessible in the task parameters area of a task or from 
the Tools menu in the main VWorks window.
Shared Services saves each pipette technique as an XML file in a VWorks Projects 
folder, for example, /VWorks Projects/VWorks/Pipetting/Techniques.
VWorks Plus only. Pipette techniques are records of interest. The software 
automatically logs audit trails for pipette techniques that are in the In Validation and 
Released states. Optionally, the software can log audit trails for these records while 
they are in the In Development state.

Inventory Editor

The Inventory Editor is for use with long-term labware storage in the Labware MiniHub.
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Labware inventory management

The inventory management system allows long-term tracking of microplates because 
barcode data is stored in a database (MySQL database). Before the Inventory Editor is 
available for use, a connection to the inventory database is required. For details on how 
to connect to the database and use the Inventory Editor, see the VWorks Automation 
Control 14.1 Setup Guide.

Information that is stored
The Inventory database maintains a list of labware located in long-term labware 
storage devices. Each labware entry in the database includes the following information:
• Device in which the labware is located
• Cassette and slot location of the labware
• Names of the location and plate groups to which it belongs
• Labware type
• Any north-side, south-side, east-side, and west-side barcodes
• Volume of the wells in the labware
VWorks Plus only. The inventory database is a record of interest (.sql) that is exempt 
from record state changes. VWorks logs an audit trail for this file.

How to access data in the Inventory database
You use the VWorks Inventory Editor to add or remove labware data in the inventory 
database. 
The list of labware in the database is automatically updated every time the robot 
moves a labware into or out of a storage device.
You can back up the inventory database by exporting it to an SQL file. 
The VWorks Backup Manager enables back up of VWorks labware definitions, liquid 
classes, and pipetting techniques in addition to the Inventory database.

Experiments Editor

Experiment IDs and Experiment database overview

Experiment IDs defined
An experiment ID is a database record that captures the steps executed and the 
settings used during each run of a protocol. Any errors that may have occurred during a 
run are also recorded. An experiment ID can be used to record the steps performed and 
settings used during the course of a sample prep workflow. 
You use the Experiments Editor to create experiment IDs, which are stored in the 
Experiments database, and to generate experiment ID reports (.pdf file).

Prerequistes
The Experiments Editor uses a PostgreSQL database, which is installed with the 
VWorks software. Before the Experiments Editor is available for use, a connection to 
the VWorks Experiments database must be established. 
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How the data is recorded
The Experiments Editor feature is designed for use with VWorks forms. VWorks forms 
have built-in features that expedite how the form’s author tags the data to be tracked. 
The data tags in the form determine which data to record for a selected experiment ID 
for the protocol being run. A pair of Step Started/Completed tasks specify each task or 
task sequence in the protocol to be recorded.
Alternatively, if you know how to write programs in JavaScript or have a basic 
understanding of programming, you can use the built-in object in the VWorks 
JavaScript interpreter instead of using VWorks forms.

Experiment ID status changes

An experiment ID has the following status transitions:
• Not yet used. Automatically assigned to a newly created experiment ID.
• Open. Automatically assigned to an experiment ID that has been associated with a 

protocol run.
• Closed. A closed experiment ID cannot be used for additional runs, and it cannot be 

reopened.
• Archived.
For VWorks Plus, the VWorks Administrator role is required to close an experiment ID. 
An experiment ID report is automatically uploaded to Content Management when an 
experiment ID is closed. If the E-Signature feature is configured, the specified 
signatures must be completed before the experiment ID closes.

Exporting and importing experiment IDs

You can export active experiment IDs from the Experiments database to files in the 
local file system. You can export the data for individual or multiple experiment IDs to a 
single file. The exported data does not include archived experiment IDs.
When importing any previously exported experiment IDs, the software performs tamper 
detection to verify that no changes were made to the exported experiment ID files.
You should periodically export the data for all active experiment IDs to create a backup 
copy of the database. You can import the backup copy to recover the experiment ID 
data in case the data become damaged or lost.
You can import the experiment IDs from a previously saved *.expTags file, for example 
as part of a data recovery process. However, you cannot import an experiment ID if it 
already exists in the Experiments database.

Device files

To communicate with and control the robot and integrated devices, the VWorks 
software uses a device file that contains the following information:
• List of devices the software will communicate with and control
• Device type of each device (for example, the robot in the lab automation system 

and any integrated device)
• Configuration information of each device (for example, approach height, allowed or 

prohibited labware, barcode reader access, and so on)
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• A link to the communication settings (profile) required for communication between 
the devices and the VWorks software

You provide the device information in the VWorks window. The device information is 
stored in a device (.dev) file.
The available devices are listed in the Available Devices area of the VWorks window. 
The Device File area provides the interface to create a device file. See “VWorks Plugins” 
on page 65 for more information on Agilent automation devices.

VWorks protocols

Protocol components

The VWorks software enables you to create protocols that automate laboratory tasks. 
A protocol consists of one or more processes. Each process consists of one or more 
tasks.

Protocols
A protocol is a schedule of tasks to be performed by a standalone device or devices 
integrated in the lab automation system. The purpose of a protocol is to process or 
perform tasks on labware.
Protocols appear in the Protocol area of the VWorks window.

Processes
A process is a sequence of tasks that are performed on a particular labware or a group 
of labware. A process is represented by a lane with white background in the Protocol 
area.
Each process lane starts with a microplate icon. The icon typically represents the 
labware or group of labware that you are processing. The labware is called the process 
plate.
A process lane can also be used as a control to initiate other processes in the protocol.

Plate instances
When a process plate icon represents a group of labware, each labware in the group is 
called a plate instance. For example, if you have 10 microplates that need to be 
processed as the Source Plate, then microplate 1 is Source Plate instance 1, microplate 
2 is Source Plate instance 2, microplate 3 is Source Plate instance 3, and so on.

Subprocesses
A subprocess is a sequence of tasks performed as a subroutine within a protocol. A 
subprocess is performed by a single device type, such as the Bravo device.
Subprocesses are represented by a subprocess icon in the protocol. 

Tasks
A task is an operation performed on one or more labware, and is represented by an icon 
in the protocol. It has associated parameters that are set in the Task Parameters area.

Macros
A VWorks macro is a collection of protocol tasks and associated task parameters 
grouped together in an abbreviated form. You can insert the macro easily at other 
places within the same protocol or throughout other protocols where the same task 
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sequence is required. A macro eliminates the need to recreate a repeated task 
sequence within the same protocols or subsequent protocols that you write. Therefore, 
protocol writing can be easier, faster, and less error-prone.

Runsets
A runset is a collection of protocol runs that can be scheduled in advance to be 
performed without operator intervention.
The following table provides an overview of how the Runset Manager works.

VWorks Plus treats protocols as records of interest that transition through record 
stages. The protocol files are stored in Content Management.

Running a protocol

The steps for running a protocol are summarized in the following table.

Table Workflow for running a protocol.

Step Task

1 You add the protocols to a runset and specify the schedule for each 
protocol, or you can open an existing runset.

2 The Runset Manager determines the most efficient way to run the 
protocols based on the following:
• The specified run start times.
• Any specified run priorities.
• Whether the protocols share the same device file.
• Whether the protocol rules permit simultaneous runs.

3 The Runset Manager opens and compiles each protocol before running it 
the specified number of times.

4 The Runset Manager repeats step 3 for each protocol in the runset.

Step Task Description

1 Turn on the devices that 
will be used in the 
protocol and prepare 
them for operation.

Instructions are in the individual device user guides.

2 Login to VWorks 
software.

Launch VWorks and sign in through the OpenLab Control Panel

3 Open a form or protocol. In the VWorks window, select Open File and select the form or protocol you 
wish to run.
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4 Set the general and view 
options.

Global options include:
• Directories and file paths

– View file paths under Tools > Options > Directories and Paths.
– Set file paths for Error library and Macro library.

• General options
– Select Tools > Options.
– Set or select options.
– Set View Options.

5 Set error-handling 
options.

VWorks automated error handling includes:
• View under Tools > Options > Error Handling area.
• Error library. A collection of automatic responses to specific error 

messages.
You select the error library file path and select the Enable error library 
option in the Options dialog box.

• Error-handling options. You set general error-handling options during 
setup or the first time a protocol is run in the software.

6 Set up email notification. You can specify that the VWorks software send you an email or text 
message when a run error occurs. Setting up email notification also 
enables bug reporting.
Alternatively, you can configure VWorks to post online messages on 
Twitter.
The following are required for the email notification to work:
• The VWorks computer must be connected to a network with internet 

access.
• The outgoing email server must be set up on the system's computer.
• In the Email Setup area of the Options dialog box, specify the email 

preferences and parameters.
The VWorks software can automatically notify you about system status via 
email and online message postings.
About setting up automatic online notification.The online posting feature 
can notify you about various system events, such as errors, deadlocks, and 
protocol and process starts and finishes. You can receive the online 
notification on any device where you can access a Twitter account.

Step Task Description
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7 Start the protocol run. When you start a run, you have the option of scheduling the protocol to run 
immediately or at a future date and time. In addition, you can specify that 
the protocol start while another is still running. 
When you schedule multiple runs:
• You can start a run while existing protocols are already running or are 

scheduled to run.
• Protocols that are running simultaneously can share devices. The 

priority of device use is specified in the device selection area when you 
set the task parameters.

• You can manage a set of runs using the Runset Manager.

8 Create and manage 
runsets.

Select File > New > Runset :
• Add protocols to the runset.
• Configure the following for the runset:

– Number of times to run the protocol
– Run start time
– Priority of runs
– Starting barcode, if using
– Notes about the protocol

9 Monitor, pause, or stop 
the runs.

In the VWorks window, select View > Progress. The Progress tab appears at 
the bottom of the window and displays the following:
• Overall progress

Displays a progress bar to indicate how far along the system is in all 
running protocols.

• Running protocols
Contains the list of protocols that are currently running.

• Display
Based on your selection in the Overall progress area, shows an aspect 
of the overall run progress.
You can display a Gantt chart for one or more protocols while they are 
running, or for one or more open protocols have been run in the current 
VWorks session since they were opened.
While a protocol is running, you can visually monitor the progress in 
real-time in the Gantt Chart dialog box. In addition, you have the option 
of displaying the progress by instance or device.
Run information displayed in the Gantt Chart format enables you to 
monitor resource usage during the run. Too much spacing (time) 
between tasks might indicate poor device usage or potential 
bottlenecks.

10 Pause the run. You can pause runs using one of the following methods:
• Pause all runs
• Pause selected runs in a runset

11 Stop the run. To stop a run in an emergency, use the hardware Emergency Stop button. 
See the device user guide for the procedure.

Step Task Description
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Protocol tasks

Protocol tasks can be divided into the following types of tasks:
• Microplate handling
• Microplate storage
• Liquid-handling
• Scheduling

Microplate-handling tasks
Microplate-handling tasks are used with Agilent Automation Devices to move labware 
into, within, and out of the Automation Workstation.
The microplate-handling tasks and their description are listed in the following table.

Table Microplate-handling tasks and their description

Task Description Available for

Centrifuge Process indicates the start of a protocol subroutine that employs 
the Microplate Centrifuge. Within the subprocess, the 
software automatically adds the Centrifuge task to spin 
microplates according to the task parameter settings.

Centrifuge and Centrifuge 
with Loader

CentrifugeAuto The CentrifugeAuto task can be used with the 
Microplate Centrifuge and Centrifuge with Loader 
devices to spin microplates according to the task 
parameter settings. The CentrifugeAuto task enables 
you to spin one microplate with a counterweight or spin 
two microplates from a protocol process, at the same 
time. Counterweights can be placed manually or 
robotically.

Centrifuge and Centrifuge 
with Loader

Configure Static 
Labeware

Available only in the Startup protocol, the Configure 
Static Labware task allows you to assign static labware 
to locations on a device. The labware will remain at 
these locations during the protocol.
Note: You can also configure static labware in the device 
subprocess task in the main protocol. Configure 
labware in the device subprocess if you want to override 
the labware configuration in the startup protocol. 
Configure labware in a Startup Protocol if the labware 
configuration will be used in all the Main Protocol 
subprocesses.
In general, you configure static labware before the first 
task in a protocol. If you have multiple processes in the 
protocol, configure the labware once before the first 
task of the first process.

Any device

Delid The Delid task removes lids from microplates. You can 
use the Delid task to remove and discard a lid, or you 
can pair it with the Relid task to retain the removed lid 
and later place the lid back on the microplate.
Note: You can only delid process plates and configured 
labware. You cannot delid static labware

BenchCel Microplate 
Handler or Bravo Platform
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Dismount The Dismount task removes labware, such as a filter 
microplate, from the top of an elution microplate or 
reservoir that is resting on a platepad. Always paired 
with a Mount task, the Dismount task uses information 
that is specified in the Mount task.

Platepad

Incubate The Incubate task moves labware to a location, leaves it 
there for a specified time period, and then moves it from 
the location. The number of labware that can be 
incubated simultaneously is limited by the number of 
locations that are available for holding labware.

Platepad

Mount The Mount task places a labware, such as a filter 
microplate, on top of a collection microplate or reservoir 
that is resting on a platepad. The Mount task works with 
the Wait For task and is paired with the Dismount task.
The Mount task becomes available when you add a 
Platepad device in the device file. The task can be used 
only in the Main Protocol.

Platepad

Move to Location 
(Agilent Bravo)

The Move to Location (Agilent Bravo) task moves the 
pipette head to a safe distance above a specified deck 
location. The safe distance is set in the Bravo profile.
Typically, this task is used in Startup and Cleanup 
Protocols to move the pipette head out of the way.

Bravo Platform

Place Plate The Place Plate task moves labware to a specified 
location. If the location has a barcode reader installed, 
the Place Plate task moves the labware to the location 
and reads the barcode.

Any device

Print and Apply The Print and Apply task allows you to:
• Specify the contents to be printed on a microplate 

label.
• Print the specified contents on a label.
• Apply the label to a labware.

Microplate Labeler

Relid The Relid task places lids on the microplates. BenchCel Microplate 
Handler or Bravo Platform

Reserve Location The Reserve Location task reserves a location on the 
Bravo Platform for a specified length of time. The task is 
typically used to incubate a microplate at that location.

Bravo Platform

Rotate Stage 
(Agilent Microplate 
Labeler)

The Rotate Stage (Agilent Microplate Labeler) task 
rotates the Microplate Labeler stage 180°. You use this 
task to change the orientation of microplates in 
preparation for label applications.

Microplate Labeler

Seal (Agilent 
PlateLoc)

The Seal (Agilent PlateLoc) task seals microplates using 
the PlateLoc Sealer.

PlateLoc Sealer

Task Description Available for
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Microplate storage tasks
Microplate storage tasks are used when there is a storage database configured in the 
VWorks software.
The microplate-storage tasks and their description are listed in the following table.

Table Microplate-storage tasks and their description

Waste If your automation system includes a trash container or 
hole, you can use the Waste task to move a lid or 
labware to the trash container or hole.

Waste Bin

Run Experiment 
(BioTek Gen5 
Reader)

The Run Experiment (BioTek Gen5 Reader) task runs the 
specified experiment on the BioTek Reader.

BioTek Gen5 Readers

Create Experiment 
(BioTek Gen5 
Reader)

The Create Experiment (BioTek Gen5 Reader) task 
enables you to set up an experiment to run on the 
BioTek Reader.

Wait for 
Temperature 
(BioTek Gen5 
Reader)

The Wait for Temperature (BioTek Gen5 Reader) task 
couples with the Set Temperature task. It pauses the 
VWorks protocol until the specified BioTek Reader’s 
incubator reaches target temperature.

Set Temperature 
(BioTek Gen5 
Reader)

The Set Temperature (BioTek Gen5 Reader) task 
preheats the BioTek Gen5 Reader for incubated reads 
where the Gen5 Experiment contains a Set Temperature 
command in the acquisition procedure.

Task Description Available for

Task Description Available for

clearinventory The clearInventory task deletes all labware data from 
the inventory database. Use this task to clear the 
inventory at the desired point in the protocol.

Any device

Downstack The Downstack taskmoves labware as follows:
• Out of the bottom of stacking devices such as the 

BenchCel Microplate Handler
• Off of the top of a stack of labware at a Bravo deck 

location

Bravo Platform and 
BenchCel Microplate 
Handler

exportDatabase The exportDatabase task exports all data in the 
inventory database to the specified location. You can 
use this task to create a backup copy of the inventory 
database at the desired point in the protocol.

Any device

importCsvToInventory The importCsvToInventory task imports labware data in 
the specified CSV file into the inventory database.

Any device

Load The Load task instructs a robot to move a defined set of 
labware into a storage device.

Labware MiniHub
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Liquid-handling tasks
Liquid-handling tasks include all tasks associated with the Bravo liquid handler and 
executed within Agilent Automation Workstation protocols. They are carried out in a 
Sub-Process of a protocol.
The liquid-handling tasks and their description are listed in the following table.

Table Liquid-handling tasks and their description

Reorder The Reorder task collects and incubates labware in a 
stack and then reverses the order of the labware in a 
second stack.

Bravo Platform and 
BenchCel Microplate 
Handler

Scan Stack The Scan Stack task scans a specified Bravo deck 
location to confirm the presence or absence of labware 
and determine the height of the stack. You must add 
one Scan Stack task for each Downstack or Upstack 
task, and at least two Scan Stack tasks for each Reorder 
task in the Bravo Subprocess.

Bravo Platform

Storage Incubate The Storage Incubate task moves a defined set of 
labware into a storage device, leaves it there for a 
specified time period, and then moves it out of the 
storage device.

Labware MiniHub

Unload The Unload task instructs a robot to move a defined set 
of labware out of a storage device.

Labware MiniHub

Upstack The Upstack task moves labware as follows:
• Into the bottom of stacking devices such as the 

BenchCel Microplate Handler
• Onto the top of a stack of labware at a Bravo deck 

location

Bravo Platform and 
BenchCel Microplate 
Handler

Task Description Available for

Task Description

SubProcess (Agilent 
Bravo)

The Subprocess (Agilent Bravo) task indicates the start of a protocol subroutine that 
employs the Bravo Platform. Within the subprocess, you can add tasks that are 
unique to the device.

Aspirate The Aspirate (Agilent Bravo) task draws liquid from a microplate or reservoir.

AM Aspirate (Agilent 
Bravo)

The AM Aspirate (Agilent Bravo) task is designed for aspirating fluids through 
AssayMAP Bravo cartridges that are mounted on the Bravo 96AM Head.

AM Dispense (Agilent 
Bravo)

The AM Dispense (Agilent Bravo) task is designed for dispensing fluids through 
AssayMAP Bravo cartridges that are mounted on the Bravo 96AM Head.

AM Mix (Agilent Bravo) The AM Mix (Agilent Bravo) task is designed for aspirating and dispensing fluids 
through AssayMAP Bravo cartridges that are mounted on the Bravo 96AM Head.
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AM Cartridges Off 
(Agilent Bravo)

The AM Cartridges Off (Agilent Bravo) task removes the AssayMAP Bravo cartridges 
from the Bravo 96AM Head. The task is available only if the device profile specifies 
the Bravo 96AM Head. You can use the AM Cartridges Off task while the head’s 
syringes contain liquid, and then subsequently dispense the liquid using the syringe 
probes.

AM Cartridges On 
(Agilent Bravo)

The AM Cartridges On (Agilent Bravo) task presses cartridges on a Bravo 96AM 
Head. The task is available only if the profile specifies the Bravo 96AM Head. You can 
use the AM Cartridges On (Bravo) task while the head’s syringes are empty or 
contain liquid.

AM Wash Syringes 
(Agilent Bravo)

The AM Wash Syringes (Agilent Bravo) task enables the following types of washes 
using the Bravo 96AM Head:
• Internal washing of the Bravo 96AM Head syringes
• External washing of the syringe probes
• External washing of the AssayMAP Bravo cartridges while mounted on the 

probes

Assemble Vacuum 
(Agilent Bravo)

The Assemble Vacuum task directs the robot to pick up the Vacuum Filtration 
Station components from designated deck locations and stack them in the order you 
specify.
The task is used in conjunction with the following tasks:
• Disassemble Vacuum
• Move and Filter Plate
• Pipette Under Vacuum Collar
• Toggle Vacuum

Dilute to Final Volume 
(Agilent Bravo)

The Dilute to Final Volume (Agilent Bravo) task allows you to transfer liquid from a 
reagent labware to a destination microplate. The task is available only if you 
specified dilution series parameters within the Format Wizard in the Hit Pick 
Replication task.

Disassemble Vacuum 
(Agilent Bravo)

The Disassemble Vacuum (Agilent Bravo) task directs the robot to remove 
components from the Vacuum Filtration Station and place them back at the 
locations specified in the Assemble Vacuum task. If a filter plate was placed on top 
of the station, the Disassemble Vacuum task directs the robot to move the 
microplate to a specified location before disassembly.

Dispense (Agilent 
Bravo)

The Dispense (Agilent Bravo) task dispenses liquid into a microplate, reservoir, or 
tubes in a tube rack.

Dispense to Waste 
(Agilent Bravo)

The Dispense to Waste (Agilent Bravo) task moves the pipettes by a horizontal offset 
and then dispenses used fluid in between the chimneys in the MicroWash Reservoir. 
The software calculates the horizontal offset automatically based on the labware 
definition for the MicroWash Reservoir (also known as the Tip Wash Station).

Hit Pick Replication 
(Agilent Bravo)

The Hit Pick Replication (Agilent Bravo) task allows you to:
• Hit pick, or transfer contents, from selected wells in a source microplate to a 

destination microplate.
• Replicate a microplate by transferring contents from a source microplate into 

multiple destination microplates.

Task Description
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Initialize Axis (Agilent 
Bravo)

The Initialize Axis (Agilent Bravo) task allows any one of the six Bravo axes (motors) 
to be initialized (homed) during a protocol run.

Mix (Agilent Bravo) The Mix (Agilent Bravo) task aspirates and dispenses liquid multiple times to mix it. 
The task allows you to specify different well-bottom distances for the aspirate and 
dispense actions.

Move and Filter Plate 
(Agilent Bravo)

The Move and Filter Plate task moves a specified filter plate from its current location 
to the Vacuum Filtration Station and then turns on and turns off the vacuum.

Pin Tool (Agilent 
Bravo)

The Pin Tool (Agilent Bravo) task can be used to perform low-volume transfers of a 
fixed volume using a pin tool. You can use the Pin Tool task repeatedly in a protocol 
subprocess to perform all the pin-tool-related steps, such as:
• Pin Tool—Adsorb
• Pin Tool—Dispense
• Pin Tool—Wash
• Pin Tool—Blot
• Pin Tool—Mix

Pipette Under Collar 
Begin and End (Agilent 
Bravo)

If the assembled Vacuum Filtration Station includes the filter plate, and you want to 
pipette into the filter plate that is underneath the collar, a pair of Pipette Under Collar 
tasks (Begin and End) are required.
• Pipette Under Collar Begin (Agilent Bravo). Prepares the Bravo device for pipetting 

in a microplate that sits under the collar of the Vacuum Filtration Station.
• Pipette Under Collar End (Agilent Bravo). Resets the Bravo device after pipetting 

under the Vacuum Filtration Station collar to prepare for subsequent tasks in the 
Bravo Subprocess.

Pump Reagent 
(Agilent Bravo)

The Pump Reagent (Agilent Bravo) task fills or empties an Auto Fill Station (wash 
station) by pumping for a specified number of seconds or until the percent of 
maximum tared weight is reached. If the reservoir is on a Weigh Station, the pump 
stops fluid flow when the target weight is reached. Otherwise, gravity drain is used to 
empty the reservoir.

Serial Dilution (Agilent 
Bravo)

The Serial Dilution (Agilent Bravo) task allows you to set up serial dilution in a 
microplate using a single task. You use the Serial Dilution wizard to set up the task 
parameters. The end result is a sequence of Aspirate, Dispense, and optional Mix 
tasks that produce a linear or non-linear concentration gradient in selected wells.

Set Head Mode 
(Agilent Bravo)

The Set Head Mode (Agilent Bravo) task specifies the channels (or barrels) in the 
pipette head to be used for pipetting. You can select an m × n array of channels 
(barrels) for one of the following configurations:
• All of the pipette channels
• The first or last full column or row of pipette channels
• Multiple full columns or rows of pipette channels
• The first or last partial column or row of pipette channels
• Multiple partial columns or rows of pipette channels
• A single pipette barrel at the corner of the pipette head

Task Description
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Set Temperature 
(Agilent Bravo)

The Set Temperature (Agilent Bravo) task sets or turns off the target temperature for 
a Heating Shaking Station accessory while a specific labware is on the station.

Set Temperature - 
Position ((Agilent 
Bravo)

The Set Temperature - Position (Agilent Bravo) task sets or turns off the target 
temperature for a Heating Shaking Station accessory, without regard to which 
labware is on the station.

Shake (Agilent Bravo) The Shake (Agilent Bravo) task instructs the Orbital Shaking Station to shake.

Shake Plate (Agilent 
Bravo)

The Shake Plate (Agilent Bravo) task instructs a Heating Shaking Station accessory 
to shake.

Tips Off (Agilent 
Bravo)

The Tips Off (Agilent Bravo) task ejects disposable pipette tips from the liquid-
handling heads that are compatible with disposable tips.

Tips On (Agilent Bravo) The Tips On (Agilent Bravo) task presses disposable pipette tips onto the liquid-
handling head. The task is not for use with fixed-tip pipette heads.

Toggle Vacuum 
(Agilent Bravo)

The Toggle Vacuum (Agilent Bravo) task turns on and turns off the vacuum in a 
Vacuum Filtration Station.

Wash Tips (Agilent 
Bravo)

The Wash Tips (Agilent Bravo) task washes pipette tips using a number of aspirate 
and dispense actions.

Run (BioTek Liquid 
Handler)

The Run BioTek Liquid Handler task runs the specified BioTek liquid-handler protocol 
on a BioTek liquid-handling device.

Task Description
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Scheduling tasks
Scheduling tasks are used to manage the timing, order, and parameters of tasks and 
processes of a protocol.
The scheduling tasks and their description are listed in the following table.

Table Scheduling tasks and their description

Task Description Available for

Define Plate Set The Define Plate Set task allows you to create an array 
variable to represent a group of process plates that will be 
processed using the same tasks in a looping routine. You 
can reference the plate set using the Location, plate 
parameter in a task.

Any device

Defince Variables The Define Variables task allows you to create variables 
and assign initial values. You can reference the variables 
in a task.
You can use the Define Variables task with the Loop and 
Loop End tasks. The Loop tasks allow you to specify the 
starting variable value, how frequently the value will 
increment or decrement, and the amount by which the 
value will increment or decrement.

Change Instance The Change Instance task allows you to change a plate 
instance within a loop. For example, you can use the 
Change Instance task within the Loop and Loop End tasks 
to aspirate from one source microplate and dispense into 
different instances of a destination microplate.

Group Begin and 
Group End

The Group Begin and Group End tasks are used together 
to:
• Group a number of tasks within a subprocess.
• Constrain the grouped tasks to run in the specified 

sequence.
• Prevent downstream tasks from starting until the 

grouped tasks are finished.
If the tasks are not grouped, the software will determine 
the fastest task sequence based on available resources.
During the protocol run, the software will make sure the 
labware needed by the grouped tasks are on the device 
locations before running the first task in the group. In 
addition, while the grouped tasks are running, only the 
microplates required by the grouped tasks will be allowed 
to be moved onto, off of, or within the device.
Use the Group Begin and Group End tasks if you want to 
control the sequence of liquid-handling tasks to make 
sure each microplate is handled the same way in the 
same sequence.

Bravo Platform
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JavaScript The JavaScript task runs the specified JavaScript at the 
desired point in the protocol. Typically, you use the 
JavaScript task to run a program that is independent of 
any task.

Any device

Loop and Loop End The Loop and Loop End tasks are used together to repeat 
a set of tasks that are within the two tasks.

Print The Print task prints barcode labels using the Microplate 
Labeler. The task does not apply labels to labware.
Use this task if you want to print labels and manually 
apply the labels to labware such as tubes or other 
containers.

Microplate Labeler 
(standalone only)

Process Control The Process Control task is used to initiate a specific 
process within the same protocol based on an upstream 
condition or the type of labware entering the process.

Any device

Signal The Signal task permits another process that is currently 
in the wait state to continue to the next task. The wait 
state is from the Wait For task in the other process.

Spawn Process The Spawn Process task is used to initiate another 
process within the same protocol. For example, to reduce 
evaporation, you can use Process Control task to deliver a 
certain labware into the system only when they are ready 
to be processed. You can also use the Process Control 
task with JavaScript code to use operator-supplied 
information to initiate a new process or funnel incoming 
labware into a different process depending on the 
barcode.

User Message The User Message task:
• Displays reminder messages. For example, the 

message can remind the operator to change pipette 
heads, empty the waste container, empty a reservoir, 
or replace labware.

• Prompts operators for variable values.
The protocol run is paused until the operator clicks 
Continue, or supplies the requested variable value and 
clicks Continue.

Wait For In a multi-process protocol, the Wait For task pauses the 
process that contains the task and waits for the go-ahead 
signal from another process before continuing to the next 
task. The go-ahead signal comes from the Signal task in 
the other process.

Task Description Available for
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VWorks forms 

A form provides a simplified interface, which can be helpful for users who have limited 
or infrequent experience with the VWorks software. VWorks administrator or technician 
access is required to create protocol forms.

Form designer overview
The Form Designer window has four primary areas:

Wait for User (Agilent 
Bravo)
Note: This task is 
available for a Bravo 
Platform that is 
equipped with a legacy 
pendant that has a Go 
button.

The Wait For User (Agilent Bravo) task pauses the 
protocol and waits until the operator presses the go 
button on the pendant. When the operator presses the go 
button, the protocol resumes.
You use the Wait For User task if you want to perform a 
task manually at the desired point in the protocol. For 
example, you can use the Wait For User task to pause the 
run so that you can manually replace a microplate on the 
deck. When you are finished, you press the go button on 
the pendant.
Note: Alternatively, you can use the User Message task to 
insert a pause in a protocol. Use the User Message task 
instead of the Wait For User task if you have easier 
access to the computer than the pendant during a run

Bravo Platform

Step Started/Step 
Completed

The Step Started/Completed task requires a connection 
to the Experiments database.
The Step Started/Completed task is used to mark a given 
Step (task sequence) in a protocol as having been started 
or having completed. Steps are used to track which tags 
are relevant to a given application run, and which have not 
had the underlying part of the protocol executed yet.

Protocols with a 
connection to the 
Experiments database

Task Description Available for

Area Description

Available Controls The control palette, which includes three categories from 
which to select controls and indicators.

Form Canvas The work area where the form’s author arranges the form 
controls while viewing a representation of the form. Three 
buttons are included in this area by default: Run Protocol, 
Pause, and Full Screen on/off.
As you drag controls into position in the Form Canvas, 
invisible grid lines assist with the alignment based on the 
controls that are already in the form.

Control Properties The properties associated with a control that is currently 
selected in the Form Canvas.
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Available controls overview
The Available Controls area of the Form Designer window contains the following areas, 
each of which provides different types of controls that you can use in your form design:

Error library

About the Error Library

If you are a VWorks administrator or technician, you can use an error library to:
• Display or hide certain error messages during a protocol run. Hiding minor errors 

reduces the number of interruptions in the protocol run.
• Automate error recovery responses for selected errors to reduce the number of 

manual interventions in a protocol run.
• Track the frequency of certain errors for troubleshooting, establishing standard 

automated recovery responses, or quality-control reporting.
You can add error messages to the error library to set up display options and 
automated responses. When you initialize a device or run a protocol and an error dialog 
box opens, click Add to Error Library to add the displayed error message to the error 
library.

Form Properties The properties that apply to the entire form, such as the 
background color and the context for JavaScript variables 
that are used in the form.

Area Description

Available Controls The control palette, which includes three categories from 
which to select controls and indicators.

General Controls area Most of the controls in the General Controls area can be 
assigned a JavaScript variable. By assigning a JavaScript 
variable, you can allow form users to edit task parameter 
values or enable the display of runtime data. The 
JavaScript variable must be assigned in both the control 
properties and in the corresponding task parameter in the 
protocol.

Specialized Buttons 
area

The Specialized Buttons area contains button controls that 
are already programmed to perform commands that are 
currently available elsewhere in the VWorks window, such 
as Run Protocol and Pause. 

Specialized Display 
Controls area

The controls in the Specialized Display Controls area 
display data that is not drawn from a JavaScript variable. 
These controls include Elapsed Time, Overall Progress, and 
Experiment ID.

Area Description
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Enabling the Error Library

In the Error Handlers tab of the Error Library tool, you can set the parameters to identify 
the error handlers. An error handler is a set of conditions that define a specific response 
to an error. For details, see the VWorks Automation Control 14.1 User Guide.

Viewing and tracking error occurrences

You can view all the errors that have occurred during the protocol run that have not yet 
been assigned an error handler. The error library records the frequency of their 
occurrences and other information to help you determine whether you want to add 
them to the library and what automated response to specify.
The list of errors can be sorted by a given parameter by clicking the corresponding 
column heading in the dialog box.

Macro Library

About macro libraries

A macro library is a collection of VWorks task macros (see “Protocol components” on 
page 33 for a definition of a task). Each macro is an abbreviated grouping of task 
sequences that you can reuse when creating protocols. 

Creating and using a macro library

If you are a VWorks administrator or technician, you can create a a Macro Library (.mlb 
file) and have the macros displayed and available when creating a protocol.
Multiple macro libraries can be created but only one macro library is used in a VWorks 
session.
Macro libraries can be managed like other protocol-associated records.

Exporting and importing

You can export and import protocols and their associated records to transport 
protocols between computers, back up and recover protocols and associated files, and 
to facilitate troubleshooting problems with protocols and other files when seeking 
assistance from Agilent Technical Support.

VWorks files you can export

You can export or import the following:
• Protocol file
• Form file
• Runset file
• Device file, including the device profile and teachpoint file
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• Macros used in the exported protocol or the entire macro library (.mlb file)
• Labware definitions
• Liquid classes
• Pipette techniques
• Hit-picking files
• Plate map files
• Barcode files
• Error library
• JSWrapper task files
• Log files
You can also export and import inventory data files. See “Inventory Editor” on page 30.

Exporting protocols and associated records

You can export files from Shared Services storage if you have administrator, 
technician, or operator privileges.
VWorks Plus only. The software performs tamper detection on the files selected for 
export and prevents you from exporting a file that is corrupted or has been modified 
outside of the VWorks software.

Importing protocols and associated records

VWorks Plus only. If the imported .vzp file was exported from VWorks 14.0 or later, the 
software does the following:
• Performs tamper detection on the imported file before parsing the file contents. If 

the software detects that the file is corrupted or has been modified outside of 
VWorks 14.0 or later, an error message appears and you cannot import the file.

• Prevents you from overwriting a protocol file of the same name if the file is in the 
validation or released state. In this case, you can import the file only if you rename 
it.

VWorks Backup Manager

You use the Backup Manager to back up and restore the Inventory databases, labware 
definitions and liquid classes, and pipette techniques. The Backup Manager stores the 
backup in a .vbk file.

VWorks logs

You cannot edit or delete log entries within the VWorks software, and you cannot 
change the storage location for the log files. However, you can download copies of the 
log files from Shared Services storage to a location of your choice.



6   VWorks specifications
VWorks logs

50 VWorks 14.1 Functional Design Specification

Types of logs

Main Log
The Main Log contains all of the actions that occur within the VWorks software, 
including changes to device profiles in the diagnostics software. The main log contents 
are listed in the following table.

Table Main Log contents

Pipette Log
The Pipette Log contains all pipetting events and error information. The pipette log 
contents are listed in the following table.

Table Pipette Log contents

Column name Description

Timestamp Time and date of the event or error.

Class Type of event or error message:
• Info
• Event
• Error
• Warning

Device Device at which the event or error occurred.

Location Location where the event or error occurred. 

Process Name of the protocol process and subprocess that is 
running.

Task Task at which the event or error occurred.

Description Description of the action that is being recorded.

File name Name and location of the protocol file.

Session ID Login session number.

Column name Description

Timestamp Time and date of the pipetting event or error.

Class Type of event or error message:
• Event
• Transfer

Session ID Login session number.

Device Device at which the event or error occurred.

Volume The volume of liquid transferred.

Aspirate Location The location at which the Aspirate task occurred.



51

6   VWorks specifications
VWorks logs

VWorks 14.1 Functional Design Specification

Time Constraints Log 
The Time Constraints Log contains all the information about time-limited task events 
and errors. The Time Constraints Log contents are listed in the following table. 

Table Time Constraints Log contents

Aspirate Selection The wells from which the fluid was drawn for the Aspirate 
task.

Dispense Location The location at which the Dispense task occurred.

Dispense Selection The wells into which the fluid was dispensed.

Location Location where the event or error occurred. 

Description Description of the action that is being recorded.

File name Name and location of the protocol file.

Column name Description

Timestamp Time and date of the event or error.

Class Type of event or error message:
• Info
• Event
• Error
• Warning

Session ID Login session number.

Start Process The name of the protocol process or subprocess that 
contains the first of the two dependent tasks.

End Process The name of the protocol process or subprocess that 
contains the second of the two dependent tasks.

End Task The task number that identifies the second of the two 
dependent tasks.

Target Interval The time specified in the Edit Time Constraints dialog box.

Allowed Deviation The time tolerance specified in the Edit Time Constraints 
dialog box.

Actual Interval The length of time of the first task during the run.

Actual Deviation The difference between the Target interval and the Actual 
interval.

Error The result of the following:
|Actual deviation| – |Allowed deviation|
If the result is less than 0, Error is set to 0.

Column name Description
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Device mini-logs 
The diagnostics software for each device plugin includes a mini-log that records 
changes to the device profile. This activity is saved in the Main Log in VWorks.

Viewing the logs

You can view the VWorks logs in the following ways:
• VWorks window. You can display the logs for the current VWorks session in the 

VWorks window.
• VWorks log files. You can display the contents of log files from previous VWorks 

sessions in the following ways:
– View a downloaded copy of the log file. If you are a VWorks administrator or 

technician, you can use the Log Management command to save a copy of a log 
file to a location of your choice. You can use a text editor, such as Notepad, to 
view the copy of the log file.

– View a log file in the Content Browser. Available only for VWorks Plus, an 
administrator can use the browser to view files in the Content Management 
repository.

Validating and saving a copy of a log file

The Log Management tool enables you to validate and save a copy of a log file.
• Save As. The software validates the selected file to determine if it has been 

altered or corrupted.
– If the validation is successful, the Save Old Log File As dialog box opens 

and allows you to save a copy. 
– If the validation is not successful, an error message appears and the 

save as procedure is aborted.
• Validate. The software validates the selected file to determine if it has been 

altered or corrupted.
The software checks the log file and displays a message that explains whether 
the validation is successful.

Description Description of the action that is being recorded.

File name Name and location of the protocol file.

Column name Description
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7 Compliance
This chapter provides the functional design specification for the compliance 
component of VWorks 14.1 software.
The topics are:
• “VWorks features that support 21 CFR Part 11” on page 54
• “Audit trail content and options” on page 55
• “Records of interest” on page 56
• “E-Signatures in VWorks” on page 60
• “Tamper detection in VWorks” on page 61
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VWorks features that support 21 CFR Part 11

The FDA rules and guidelines for compliant electronic records and computerized 
systems require secure data handling. The following table lists the applicable VWorks 
Plus features.

Table Features that support 21 CFR Part 11

Feature Description

Authentication, security, and 
user management

Prevent unauthorized access and unauthorized modification of records of 
interest. The Control Panel enables management of users, groups, roles, and 
privileges.

Content Management Provides secure storage with access control.

Control Panel system activity 
log

Records events that occur during a Control Panel session, for example, 
logging in, updates to users, groups, or roles, updates to licenses, and so 
forth.

Backup and restore procedures 
for the software and Content 
Management.

Provide procedures required for disaster recovery planning.

VWorks activity logs Record events that occur during a VWorks session. The logs include the 
Main log, Pipette log, and Time Constraints log.
The Diagnostics software for each device displays a profile activity log, 
which is also stored in the Main Log.

Audit trails and reports Provides traceability for records of interest, documenting who did what and 
when.
An audit file is logged for each record of interest.

Record state tracking Provides control of records that transition through development, validation 
and released states to ensure record integrity and traceability. The software 
also increments the version of a record of interest each time a change is 
saved.

Electronic signatures Enables e-signatures allowing users to sign off on a record before 
transitioning it to the next record state and to close an experiment ID.

Tamper detection Detects corrupted records and records that have been modified externally 
from VWorks Plus.

Exporting and importing 
protocols

Provides a means to export protocols and associated components to an 
archive file (.vzp) that can be used to transport protocols between 
computers, back up and recover protocols, and facilitate troubleshooting 
problems with protocols and other files when seeking assistance from 
Agilent Technical Support.
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Audit trail content and options

VWorks Plus logs audit trails for files that are considered to be records of interest (ROI). 
Each record is stored in the Content Management Repository and includes its audit trail 
and a checksum file. The software uses the checksum file for tamper detection.
The audit trail contains the following for each change to a record of interest.

Table Audit trail contents

Backup and Restore features Provides a means to backup and restore the following files from an archive 
file (.vbk).
• Labware entries
• Labware classes
• Liquid classes
• Pipetting techniques
• Database file (.sql) for labware inventory

Feature Description

Column Description

Local Time The local date and time of a change to the record of interest.

UTC Time The UTC date and time of a change to the record of interest.

Computer name The name of the computer on which audit trail is generated.

Software Version The version and build of the VWorks software running on the computer 
listed above.

User The user name of the logged-in user who made the change to the record of 
interest.

State of ROI  The development state of the record of interest:
• Released, In Validation, or, if applicable, In Development. 

Logging an audit trail for records in the development state is optional.
• Pending. A record that is pending one or more esignatures.
• Exempt. For details, see “Records exempt from state changes” on 

page 57.

Description A software-generated description of what the changes were.

Audit Comment A comment (reason for the change) that the user entered in the Audit 
Comment dialog box for this change.
Whenever a record for which the software has logged an audit trail is 
modified, the Audit Comment dialog box opens and requires the user to 
enter a comment before saving the record. Comments are restricted to 256 
characters.
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Audit trail options

By default, the VWorks software is not configured to log audit trails for records that are 
in development. If you want to log audit trails for records in development, you can use 
the options in the Options dialog box to set your preferences.
The audit trail options are described in the following table.

Table Audit trail options

Audit trail reports

Audit reports can be generated for any audit trail of a record of interest. The software 
performs tamper detection on any record selected for the audit trail report. A report 
cannot be generated for a record if the software detects tampering or corruption of that 
file.

Records of interest

VWorks has two categories for records of interest:

1 Records that are subject to development state changes
2 Records exempt from state changes

Records that are subject to development state changes

Records of interest can exist in any of the following four state stages:
• In Development. By default, the software does not create an audit trail log for 

records in development. However, the software includes an option to log the audit 
trail entries for In Development records.

• In Validation. An audit trail is logged for In Validation records. Such records may be 
modified but not deleted. The Audit Comment dialog appears any time you modify 
and save a record in this state.

• Released. The software prevents any changes to records that are in the Released 
state. If you attempt to save a change for a released record, a message appears 
stating This record is released and cannot be changed.

Column Description

Log audit trail for records of 
interest that are in development 
state

The option to maintain an audit trail for development state records.
You cannot delete records for which VWorks logs an audit trail.

Automatically change the state 
of dependent records

The option to automate record state changes for dependent records when 
you change the state of a record of interest.

Prompt user with a list of device 
profiles when running a 
protocol in RELEASED state

The option to list all the referenced device profiles that are in the validation 
state when running a protocol that is in the released state, or when running a 
protocol that references a device file that is in the released state.
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Records exempt from state changes

VWorks logs all the audit trail entries for an exempt record of interest starting from the 
creation of the file. The Audit Comment dialog appears any time you modify and save a 
record of interest that is exempt from record states.

Table Records of interest that are exempt from record state changes

VWorks records that transition through states

The following table lists the records of interest (ROI) that are tracked based on their 
development state. Changes to this type of record:
• In Development. Changes may be logged to an audit trail depending on the setting 

in the Options dialog box.

Record of interest (file 
extension)

Description

VWorksOptions (.xml) A global options file that specifies parameter settings that apply to all the 
protocols on the computer running VWorks Plus.
The software logs an audit trail for this record, starting with the creation of 
the record and tracks any subsequent changes.

Labware class (.xml)** A file that lists a collection of labware entries that can be used with a given 
device, for example, Uses Standard Platepad or Uses Filter Platepad.

Teachpoint file (.xml) A device-dependent file that contains your teachpoint settings, for example, 
a BenchCel teachpoint file.

Miscellaneous files that are imported into the Content Management Repository.
The software logs an audit trail for the following records after they are imported into the Repository.

Barcode files (.bar, .csv, or .txt) An input file for specifying the barcodes to apply to a microplate.

Excel files (.xlsx, .xls, or .xlsm) A utility for calculating volume requirements or for creating a method used 
by the AssayMAP Protein Sample Prep Workbench.

Gantt chart files (.gnt) An input file used by the Hit Pick Replication task. The file contains 
information about the source microplate and specifies the dispense pattern 
in destination microplates.

Hitpick input files (.csv) An input file used by the Hit Pick Replication task. The file contains 
information about the source microplate and specifies the dispense pattern 
in destination microplates.

Image files (.jpg, .png, .bmp, or 
.ico)

A labware inventory database file.

Experiments database files 
(.expTags)

Archived files and exported files that contain experiment data in XML 
format.
The software saves these files to the local file system, not Shared Services 
storage. 

JavaScript (.js) A text file that contains JavaScript code that is used to execute instructions, 
for example, in a protocol task.
The JS Wrapper task uses a JavaScript task file (.js).
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• In Validation. Changes are always logged to an audit trail.
• Released. No changes are permitted.

Table Records of interest that are tracked based on their development state

Record of interest editing

Each record of interest that transitions through the record states has different limits on 
editing or deleting files, as described in the following table.

Record of interest (file 
extension)

Description

Device file (.dev)  A file that contains:
• The list of devices the software will communicate with and control
• Configuration information of each device
• Communication settings (profile)

Device profile (.xml) A file that contains a collection of settings that the VWorks software uses to 
communicate with a specific device, for example, the Bravo Platform.
Although profiles can transition from the In Development state to the In 
Validation state, these records cannot transition to the Released state. This 
exception is necessary because adjustments to the teachpoints for a given 
device may be required if the instrument is moved to another location or if a 
hardware collision occurs. A teachpoint adjustment would result in an 
update to the device profile.

Error library (.elb) A file that contains a collection of automated error responses.

Form file (.VWform) A file that provides a simplified user interface for running a protocol.

Hit pick format (.xml) A file that is used by hit picking protocols to specify the destination well 
pattern and a few other items.

Labware entry (.xml) A file that contains a collection of labware properties that the VWorks 
software uses to handle a given labware type in the automation system.
Note: Each labware entry is assigned to a labware class or classes. Labware 
classes are exempt from record state changes, but labware entries in the 
released state cannot be removed from a labware class.

Liquid class (.xml) A file that specifies pipetting settings, set up for different liquid types.

Macro library (.mlb) A file that contains a collection of macros. A macro is a collection of 
protocol tasks in an abbreviated form that you can insert at various places 
within the same protocol or throughout other protocols where the same task 
sequence is required.

Pipette technique (.xml) A file that specifies the x- and y-axis offset when pipetting.

Protocol file (.pro) A file that contains instructions for performing a run.

Runset file (.rst) A file that specifies a collection of protocol runs that can be scheduled in 
advance to be performed without operator intervention.
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Table Editing options in different record states

Protocols and record-state dependencies

A VWorks protocol has dependencies on other records of interest, such as a device file, 
labware entries, and so forth. To run a protocol successfully, the dependent records 
must have a state equal to or greater than the protocol. For example, if you attempt to 
run a released protocol with labware entries that are still in validation, an error message 
appears and you must abort the protocol.
The following table lists record states permitted for dependent records at each 
development state of the protocol.

Labware classes and teachpoint files (BenchCel) are exempt from record state 
changes.
Device profiles cannot transition to the released state, because teachpoint 
adjustments may be required if a device is moved to another location or if a hardware 
collision occurs.

Record state Description Editing of record allowed?

In Development The VWorks software assigns this state to 
new records.
By default, the software does not log an audit 
trail records in development.

Administrator or VWorks technician 
may edit files.
Only administrator can delete files.

Pending The VWorks software assigns this state to a 
record that is awaiting one of more  
e-signatures before transitioning to the next 
state.

No editing or deleting allowed.

In Validation A VWorks administrator or technician can 
change the record state from In Development 
to In Validation.
The software logs an audit trail for all In 
Validation records.

VWorks administrator or technician 
may edit but cannot delete these 
files.

Released A VWorks administrator or technician can 
change the record state from In Validation to 
Released.
The software logs an audit trail for all 
Released records.

No editing or deleting allowed.

State of the protocol State of the dependent records

In Development Any of the 3 record states

In Validation In Validation or Released only

Released Released only
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Prerequisites of record state changes

• VWorks Technician privileges or greater are required to change the state of the 
record. 

• If e-signatures are enabled, all specified e-signature levels must be completed to 
transition a record. 

• You cannot change a record’s state if it references other records that are at a lower 
state.
For example, if you are transitioning a protocol from In Development to In 
Validation, the labware entries must have a state of at least In Validation. In this 
case, you can either:
– Manually change the state of each dependent record before transitioning the 

protocol.
– Select the option for the software to change the state of dependent records 

automatically. 

E-Signatures in VWorks

Signature levels specify the users or user groups that may sign records and the order in 
which the users may sign. An administrator initially configures the signature levels in 
OpenLab Control Panel. For details, see the VWorks Plus Configuration and 
Administration Guide.

Prerequisites

The OpenLab electronic signature service uses a PostgreSQL database, which is 
installed with the VWorks software. Before the E-Signatures feature is available for 
VWorks use, a connection to the VWorks E-Signatures database must also be 
established.

Records that can be signed

The VWorks software can prompt for a signature in the following cases.

E-Signature contents

E-Signatures store the following information.

Record type E-signature requirements

Records of interest 
that transition 
through record 
states

E-signatures are required to transition a record from
• In Development to In Validation
• In Validation to Released
If the user who initiates the transition has the credentials to 
sign at this stage, a dialog box opens and provides this option.

Experiment IDs E-signatures are required when an experiment ID is closed.
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Table E-Signature record contents

Tamper detection in VWorks

Tamper detection verifies the data integrity of records of interest. The feature detects 
corrupted records and records that have been modified outside of the VWorks 
software.
Examples of tampering include:
• Deleting any file from a record of interest archive (.roiZip) in Content Management.

Note: All records of interest are stored in an .roiZip archive that includes the 
audit trail file and a checksum file.

• Modifying parameter values in any file outside of the VWorks software.
• Changing the structure of an .xml file, such as removing any closing or opening 

XML tag.
If the software detects tampering, an error message advises you that the file cannot be 
loaded and to contact the VWorks administrator to try to recover the file. In this case, 
the VWorks administrator can restore a backup copy or use the Content Browser to 
recover a previous version of the record. For details, see Guides for VWorks Plus 
edition.

When does tamper detection occur
The Vworks software performs tamper detection for the following actions:

Table When tamper detection occurs

Column Description

Level The numeric signature level. Up to 5 levels may be configured, 
where 5 is the highest level signature. 

Level Name  The level name assigned by the administrator. 

Signed By  The full user name and (user login).

Local Time  The datetime stamp in local time.

UTC Time The datetime stamp in UTC time.

Meaning The meaning of the signature level.

Comment  The comment entered by the user when signing.

Is valid? True indicates that a signature was posted successfully.
False indicates previously posted signatures that were revoked.

Action Description

Starting the VWorks software and 
logging in

Checks the VWorks Options.xml file for tampering as well as any files 
referenced in VWorks Options, for example ErrorLibrary.elb or 
MacroLibrary.mlb files. 

Using the Tamper Detection 
command

Checks the records of interest stored in the Content Management 
Repository to verify the data integrity. 
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Tamper detection responses when opening a record of interest
When you open a record of interest, the software checks the given record for data 
integrity before loading it. If a record is corrupted or has been tampered, the response 
can vary depending on the file, as the following table shows. To resolve the problem, an 
administrator can use the Content Browser to restore a previous, clean version of a 
record.

Table VWorks response to a corrupted or tampered record

Opening a record of interest Checks the record for data integrity before opening the file. 

Performing a protocol run Checks the protocol when the protocol is compiled.
During a run, tamper detection occurs at the point in the run when a task 
parameter value is set by a script or variable and the task actually 
executes.

Importing a VWorks protocol 
archive (.vzp file)

Checks the .vzp archive contents if the .vzp was created in VWorks 
version 14 or later.

Importing or restoring 
experiments in the Experiments 
Editor

Checks an experiment file that was archived or exported before allowing 
you to restore or import the file.

Importing an Inventory database 
file (.sql)

Checks the file that was exported before allowing you to import the file.

Using VWorks Backup and 
Restore (.vbk file)

Checks the selected files during:
• Backup. An error message lists any corrupted records and provides 

the option to continue the backup for clean records only.
• Restore. A Restore operation cannot proceed if the backup (.vbk file) 

is corrupted or has been tampered.

Generating an audit trail report Checks the selected record of interest, and generates the audit trail report 
if the record has not been corrupted or tampered.

Action Description

Type of record VWorks response if record is corrupted or has been tampered

A single record of interest, for 
example, a device file or labware 
entry

A message states that the file has been corrupted or modified outside of 
the VWorks software and cannot be loaded.
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Restoring records
An administrator can restore records in the following ways:
• Rollback the version of a selected record to a previous clean version in the Content 

Browser.
• Restore records from a clean backup copy.

A record of interest that 
references or contains other 
records

The software response depends on the record type, for example:
• Runset that includes a corrupted protocol. A message lists the 

corrupted record and states that the runset cannot be loaded.
• Protocol that references a corrupted record. A message lists the 

corrupted record and states that the record cannot be loaded.
• Form that references a corrupted record. The form loads successfully, 

but the corrupted record (for example, protocol, device file, or runset) 
cannot be loaded.

• Labware class that contains a corrupted labware entry. The labware 
class loads successfully, but the corrupted labware entry cannot be 
loaded.

VWorks Options.xml file (Options 
dialog box)

The software response depends on the issue:
• If the VWorksOptions.xml file is corrupted or tampered, an error 

message states that the VWorks software must close. In this case, 
an administrator can use the Content Browser to restore a clean 
backup copy of the file or a previous version of the file.

• If a file referenced by VWorks Options, such as the error library or 
macro library, is corrupted or missing an error message states that 
the file cannot be loaded.

• If the VWorks Options.xml file is missing, a error message opens and 
advises that the software will load the default values for VWorks 
Options.
An administrator can click Tools > Options, and then verify the 
settings in the Options dialog box.

Error library or macro library A message states that the file has been corrupted or modified outside of 
the VWorks software and cannot be loaded.

Type of record VWorks response if record is corrupted or has been tampered
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8 VWorks Plugins
This chapter provides an overview of the devices supported by VWorks 14.1 
software.
The topics are:
• “Devices supported by VWorks” on page 66
• “Bravo Platform” on page 66
• “BioTek Liquid Handler” on page 68
• “BenchCel Microplate Handler” on page 68
• “Centrifuge with Loader” on page 68
• “Microplate Labeler” on page 68
• “BioTek Gen5 Reader” on page 68
• “Microscan Barcode Reader (Mirrored Barcode Reader)” on page 69
• “Labware MiniHub” on page 69
• “PlateLoc Sealer” on page 69
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Devices supported by VWorks

Device Plugins

The VWorks software uses device plugins to communicate with and control Agilent 
specific devices. A device can be a robot, an instrument, or a location in the lab 
automation system that can hold a piece of labware.
When you start the VWorks software, the icons of the plugins for the supported devices 
are listed in the Available Devices area of the window.

Bravo Platform

The Bravo Platform is a versatile liquid handler with a nine plate-location deck that is 
suitable for handling 96-well, 384-well, and 1536-well microplates (plates). The platform 
uses interchangeable liquid-handling heads. It can also be equipped with a gripper that 
enables automatic microplate pickup and placement.

Device type Description

Labware-handling devices • Agilent BenchCel
• Agilent Centrifuge
• Agilent Centrifuge Loader
• Agilent Labware MiniHub
• Agilent Microplate Labeler
• Agilent Microscan Barcode Reader (Mirrored 

Barcode Reader)
• Agilent PlateLoc

Liquid-handling devices • Agilent Bravo
• BioTek Liquid Handler (VWorks 14.1 and 

later)

Microplate readers BioTek Gen5 Reader (VWorks 14.1 and later)

Phantom devices Virtual devices that permit the manual 
movement of labware during a protocol run:
• Agilent Phantom Human Robot
• Agilent Phantom Stacker

Location devices Devices where you can place a piece of labware:
• Platepad (installed outside of Bravo 

Platform)
• Waste Bin

Devices for manufacturing use 
only

• Agilent Generic I/O Module
• Agilent Generic RS-232 Device
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To ensure pipetting accuracy, Bravo IQOQ is available for purchase. See “Bravo IQOQ” 
on page 11.
The Bravo Platform can be used in the following ways:
• As a single device controlled by a computer
• Integrated with other devices in a lab automation system
For example, when used as a single device, it can be placed in a laminar flow hood for 
use with cell-based applications or handling potentially hazardous materials.
As an integrated device in a lab automation system, it can be used to prepare 
microplates for high-throughput screening or other automated process.
The Bravo Platform can be accompanied by a multitude of accessories some of which 
are listed in the table below. For a complete list of all available accessories and more 
detailed information, see the Bravo Platform User Guide. 

Table Some of the accessories available for the Bravo Platform

Accessory Description

Autofilling 
accessories

Consists of the following:
• Pump Module
• Auto Filling Reservoir, Tip Wash Station, or Open Wash Tray
• Weigh Station (optional)
The pump module has two peristaltic pumps, one that pumps the 
fresh source fluid into a reservoir, and a second one that pumps 
the waste fluid from the reservoir. Optionally, you can use the 
Pump Module with an Agilent Weigh Station to provide precise 
liquid- level control for an autofilling reservoir or wash station.

Peltier Thermal 
Station

Uses Peltier technology to provide temperature control uniformly 
across a microplate. The station uses the Inheco Single TEC 
Control (STC) or Multi TEC Control (MTC).

Heating 
Shaking 
Station

Provides heating and fluid mixing across a microplate. The station 
uses the Inheco Single TEC Control (STC) or Multi TEC Control 
(MTC).

Orbital Shaking 
Station

Mixes labware contents using a shaking motion.

Vacuum 
Filtration 
Station

Uses vacuum to filter the contents of a microplate.

Filter Plate 
Holder

Provides a location for a filter plate while awaiting assembly of the 
Vacuum Filtration Station and when disassembling the station.

Thermal 
Station

Uses a fluid-filled thermal block to provide temperature control 
uniformly across a microplate.
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BioTek Liquid Handler

The BioTek Liquid Handler plugin can be used with various models of BioTek liquid 
handlers. For a list, see the BioTek Liquid Handler Device Guide for your VWorks 
version.

BenchCel Microplate Handler

The BenchCel Microplate Handler is a microplate-processing automation device that:
• Stores stacks of labware (microplates, tip boxes, and tube racks) to be processed 

during a protocol run.
• Moves labware to and from integrated devices such as the Bravo Platform, 

PlateLoc Thermal Microplate Sealer, or Microplate Labeler for processing.

Centrifuge with Loader

The Agilent Microplate Centrifuge with Loader consists of an automated centrifuge and 
a robotic microplate handler:
• The Centrifuge has two buckets, each capable of carrying a single microplate, filter 

plate, or lidded microplate. 
• The Loader has a plate stage and a gripper that enables microplate placement by a 

robotic arm in your automation system. After the robot places a microplate onto 
the Loader plate stage, the gripper picks up the microplate and moves it into the 
Centrifuge.

The Centrifuge with Loader is intended to be integrated with a robotic lab automation 
system.

Microplate Labeler

The Microplate Labeler prints labels and applies them to labware.
You can create and apply the same or a different label on up to four sides of a 
microplate. Each label can include up to six fields, including a barcode field and human-
readable text fields.
A Microplate Labeler can be used in the following configurations:
• Integrated in a BenchCel workstation
• As a standalone device
• Integrated with a third-party lab automation system

BioTek Gen5 Reader

The BioTek Gen5 Reader plugin can be used with various models of BioTek Gen5 
readers. For a list, see the BioTek Gen5 Reader Device Guide for your VWorks version.
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VWorks Plus 14.1 requires BioTek Gen5 Reader protocols and experiment files to be 
stored on local drive in visible Windows directories. Gen5 protocols and experiments 
can be copied to a more secured location once data acquisition and processing is 
complete. 

Microscan Barcode Reader (Mirrored Barcode Reader)

The Microscan Barcode Reader scans barcode labels affixed to a side of a piece of 
labware.
When used on a Bravo Platform, the Microscan Barcode Reader consists of a platepad 
with a barcode reader sensor head and a mirror. The Microscan Barcode Reader can 
be installed in place of a platepad at any deck location and is designed to scan 
barcodes on the east or west side of microplates.

Labware MiniHub

The Labware MiniHub is a rotating random-access labware storage device. Up to four 
labware can be placed on each shelf. Spacing blocks, also called spacers, can be 
added or removed to adjust the distance between shelves, accommodating different 
labware types (microplates, tip boxes, or tube racks).
The Labware MiniHub is designed to be configured with the BenchCel Microplate 
Handler.

PlateLoc Sealer

The PlateLoc Sealer applies a sealing material on top of microplates to seal individual 
wells. 
The PlateLoc Sealer can be used as a standalone device or in a robotic lab automation 
system. 
The Gas-Purging PlateLoc uses argon gas to displace air, containing moisture and 
oxygen, in the microplate immediately before the sealing begins. Because argon is 
inert, it does not react with the microplate contents. The microplate contents can be 
protected from hydration and oxidation for up to 24 hours.
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